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	Alternate & Mix Mixes pages from 2 or more documents, alternating between them
	Merge Combine multiple PDFs and images into one
	Organize Arrange and reorder PDF pages
	Extract Pages Get a new document containing only the desired pages
	Split by pages Split specific page ranges or extract every page into a separate document
	Split by bookmarks Extract chapters to separate documents based on the bookmarks in the table of contents
	Split in half Split two page layout scans, A3 to double A4 or A4 to double A5
	Split by size Get multiple smaller documents with specific file sizes
	Split by text Extract separate documents when specific text changes from page to page
	Edit & Sign
	Edit Edit PDF files for free. Fill & sign PDF. Add text, links, images and shapes. Edit existing PDF text. Annotate PDF
	Fill & Sign Add signature to PDF. Fill out PDF forms
	Create Forms Free PDF forms creator. Make existing PDF documents fillable
	Delete Pages Remove pages from a PDF document
	Compress Reduce the size of your PDF
	Protect Protect file with password and permissions
	Unlock Remove restrictions and password from PDF files
	Watermark Add image or text watermark to PDF documents
	Flatten Makes fillable PDFs read-only. Print & scan in one step
	Convert from PDF
	PDF to Excel Convert PDF to Excel or CSV online for free. Extract table data from PDF
	PDF to JPG Get PDF pages converted to JPG, PNG or TIFF images
	PDF to PowerPoint Convert PDF to PowerPoint online
	PDF to Text Copies all text from the PDF document and extracts it to a separate text file
	PDF to Word Convert from PDF to DOC online
	Convert to PDF
	HTML to PDF Convert web pages or HTML files to PDF documents
	JPG to PDF Convert Images to PDF
	Word to PDF Creates a PDF document from Microsoft Word .docx
	Deskew New Automatically straighten and deskew scanned PDF pages
	OCR Convert PDF scans to searchable text and PDFs. Extract text from scans
	Workflows New Execute series of tasks on PDF documents. Configure tool chains to process PDFs
	Bates Numbering Bates stamp multiple files at once
	Create Bookmarks New Create PDF Bookmarks
	Crop Trim PDF margins, change PDF page size
	Edit Metadata Change PDF Author, Title, Keywords, Subject and other metadata fields
	Extract Images Extract images from PDF
	Grayscale Make a PDF text and images grayscale
	Header & Footer Apply page numbers or text labels to PDF files
	N-up Print multiple pages per sheet per paper. A5 plan as 4-up on A3 or A4 2-up on A3
	Page Numbers Add PDF page numbers
	Rename New Change document filename based on text from the PDF pages
	Repair Recover data from a corrupted or damaged PDF document
	Resize Add page margins and padding, Change PDF page size
	Rotate Rotate and save PDF pages permanently
	Remove annotations New Batch remove highlights, strikeouts or any other annotations from a PDF document


Online PDF editor
Edit pdf files for free. fill & sign pdf.
	More fonts...
	Carlito (Calibri)
	DejaVu Sans (Verdana)
	Droid Serif
	EB Garamond
	Liberation Sans (Arial)
	Open Sans Condensed
	Oranienbaum
	PT Sans Caption
	PT Sans Narrow
	PT Serif Caption
	Times New Roman

Too many attempts. Please try again later. Sorry, your file is too large.
You reached your free limit of 30 files per hour. please upgrade to continue processing this task. you reached your free limit of 3 tasks per hour. please upgrade to continue processing this task or break for 00:59:00 . you reached your free limit of 50 mb per file. please upgrade to continue processing this task. you reached your free limit of 5mb per image file. please upgrade to continue processing this task. free users are limited to a single file per task. please upgrade to continue processing multiple files at once. you reached your free limit of 50 pages. please upgrade to continue processing this task. free users are limited to 20 pages per conversion. please upgrade to continue processing this task. free users are limited to 20 links per task. please upgrade to continue processing up to 100 links at once. free users are limited to 10 pages per ocr task. please upgrade to continue processing this document. free users are limited to 50 pages per conversion. please upgrade to continue processing this document. free users are limited to 5 files per rename task. please upgrade to continue processing this task. free users are limited to 1 workflow. please upgrade to use more workflows..

	Web Address (URL)


Files stay private. Automatically deleted after 2 hours. Free service for documents up to 200 pages or 50 MB and 3 tasks per hour.
Password for file.pdf
Paste the web address of the file:.
Could not upload your file: . You won't be able to save changes until the upload is successful.
How To Edit PDF Files Online For Free
Edit & sign pdf files online for free. fill out pdf forms online. change pdf text add text to pdf. edit existing pdf text. add image to pdf create links in pdf. edit hyperlinks in pdf. annotate pdf, upload your files.
Files are safely uploaded over an encrypted connection. Files stay secure. After processing, they are permanently deleted.
Rather not upload your files and work with them offline? Try Sejda Desktop . Same features as the online service, and the files never leave your computer. Use all your locally installed fonts.
Click 'Upload' and select files from your local computer.
Dragging and dropping files to the page also works.
Dropbox or Google Drive files
You can pick PDF files from Dropbox or Google Drive too.
Expand the 'Upload' dropdown and select your files.
Add text to PDF. Type on a PDF
Make sure the 'Text' tool is selected. Click anywhere on the PDF page to add text.
Change PDF text
Select the 'Text' tool in the top toolbar. Click any existing text to start editing. Make text bold or italic, change font size, font family and text color.
Add image to PDF
Click the 'Images' menu and select 'New Image'. Select an image from your computer and then add it to the PDF page. You can drag with your mouse to move it, drag on the corners to resize it.
Fill out PDF forms
Click any form field in the PDF and start typing. Form contains no input fields? Select the 'Text' tool to type text and the 'Forms' tool for checkmarks and radio bullets.
Add links to PDF and edit existing hyperlinks
Add new links to web URLs or pages in the document. Easily edit existing hyperlinks in the PDF.
Whiteout PDF
Cover part of the PDF page with a white rectangle so the contents is no longer visible.
Click the 'Shape' tool to add rectangular or ellipsis shapes to a PDF page. Change border or background fill color.
Find and replace in PDF
Easily find and replace all occurrences of words in a PDF.
Add form fields to PDF
Click on 'Forms' in the top menu and select the type of form input you want to add: Text, Multiline Text, Dropdown, Checkbox, Radio choices.
Click on the desired form field type and place it on the page. Enter the new field's name and, optionally, the default value.
Annotate PDF pages
Use the PDF annotator to strikethrough and highlight text on PDF pages. Click on 'Annotate', then choose the style and select text on page to apply.

Save your changes
Click the 'Apply changes' button to apply the changes and then 'Download' your edited PDF document.
Ready to edit your PDF online?
How to sign pdf, below we show how to add your signature to a pdf document, select your pdf document.
Click on 'Upload' to choose a file.
Create a signature
Click 'Sign' and then 'Add Signature' to create a new signature.

There are 3 methods to create a signature:
	Type your name
	Draw your signature using your mouse or trackpad
	Upload an image with your signature

Type your signature
Type your name and select the style you like best. You can choose from over 10 handwriting styles.

Draw your signature
Using your mouse, trackpad or pointer device draw your signature on the screen.

Add signature to a PDF page
Expand the Sign menu dropdown and select your signature. Scroll the page and click where you want to place it.
You can resize the signature by dragging on its corners.
Ready to sign a PDF online?
How to type on a pdf, type text on a pdf, ready to type on your pdf, how to edit pdf on mac, edit in your browser with our online pdf editor.
Open the online PDF editor with Safari or your other favourite browser.
Edit with our offline Mac PDF editor app
Download and install Sejda Desktop for Mac and edit your PDF files offline. Sejda Desktop
Ready to edit your PDF on a Mac?
	Find & Replace
	Add text and symbols


	Add new form fields
	Change existing form fields
	Make fields editable
	Delete existing image


	New Signature
	Hide annotations

You've previously made edits to this file. Would you like to recover any unsaved changes?
We detected you are using your browser's zoom. This breaks the editor. Please reset your browser's zoom back to 100%. Learn how
	Upload Image

Sign your name using your mouse or touchpad.
Click 'Allow' in the pop-up above to activate your camera
Sign on a white piece of paper and hold it in front of the camera.
Transparent A
Transparent B
Contact SEJDA.COM support
Email us at [email protected] or use the form below.
We'll use this data to help you faster. Confidential.
Please share a screenshot of the problem, as you see it.
This online PDF editor allows you to directly edit a PDF document. Add text or images or draw boxes, circles and arrows on your PDF page. You can also highlight passages or add a watermark to the PDF.

Stay connected:
How to edit a PDF file?
	Upload the file you want to edit.
	Click on a page thumbnail on the left.
	Choose an editing tool from the menu above the preview.
	Draw, write, etc. on the full-size image of your PDF. You can zoom in and out on the page using the magnifying glasses buttons, undo changes, reset the whole page, and so on.
	Change the color, font, stroke size, etc. by opening the "Options" menu on the left.
	Click on "Save" and once more on the "Save" button to receive your edited PDF.


Online PDF Editor for free and wherever you want
How to edit a pdf.
Drag and drop your file into the box above to upload it. Browsing your computer or using a document from a cloud service is possible as well, of course.
This is how our versatile PDF editing tool works: On the left, you see the thumbnails of your PDF pages. Choose the one you want to edit. Above the preview, you can choose the actions you want to take. Additional actions like undo, redo, and zoom are also available. For more options such as stroke size, font color, etc. just open the "Options" menu.
Edit PDF Documents Online
To edit Adobe PDF files you don't need to download and install a new program. You can now do so for free with PDF2Go!
Don't bother with malware and viruses or overcrowding your hard drive. When editing your PDF online, all you have to download in the end is the finished file!
Why Use A PDF Editor?
You want to write notes onto your PDF? Circle an especially important part? Highlight essential text passages? Then you have to print it out...
Not anymore! Using PDF2Go you can not only draw onto a PDF to your heart's content, but also add images and watermarks.
100% Secure PDF Editing
Your files are safe with us! All files uploaded to PDF2Go are handled automatically. This means that no one gets to see the file's content but you.
Of course you remain the rightful owner of the PDF file as well.
If you still got any questions, feel free to check our Privacy Policy.
Can I Edit My PDF?
Yes, you can. It doesn't matter if your PDF contains tables, images, or several columns of text – PDF2Go allows you to edit your PDF file.
PDF Editing Wherever You Are
You don't need to be at home on your computer to edit a PDF document. PDF2Go is named as such for a reason. Edit your PDF from anywhere with a stable internet connection.
We support smartphones, tablets, computers, laptops, as well as browsers like Chrome, Opera, Safari, Firefox and more!
Rate this tool 4.5 / 5
You need to convert and download at least 1 file to provide feedback
Feedback sent
Thank you for your vote
Blog & Articles
Find out how to edit PDF files

PDF2Go Educational Account - All You Need To Know
Find out how to open an educational account and use all PDF2Go tools completely free of charge.

Paperless Office – The Future Of Doing Business
Read our top 6 reasons for implementing a paperless office today! Find out why is this way of doing business efficient, preferable, and environmentally friendly.
Dictionary & File Formats
PDF is short for Portable Document Format. PDF documents can contain formatted text, different fonts, hyperlinks, images, and even media such as sounds and videos.
File Format
DOCX is the file format used by Microsoft Word. Documents created with the program are saved using the .docx file extension.
OCR is short for Optical Character Recognition. This process is used to recognize the visual representation of text, for example in an image.
Specify a downloader that fits your task

Edit PDF documents for free with powerful yet simple online PDF editor
Edit pdf text, secure pdf editor, add text and images, sign pdf documents, increase productivity, variety of tools to modify pdf.
Use this tool at least once to rate it.
How to edit a PDF online?
Pdf editor faqs.


Edit and sign PDF files online. Easy to use. No software required.
Drag your PDF here
Easy editing
The best online PDF editor you'll ever use! Fill out forms, add signatures, white out and highlight without breaking a sweat.
Works anywhere
Edit PDFs on your PC, Mac, or Chromebook. There's no software to install- all you need is the web browser you're using right now!
Safe and secure
PDF Buddy uses Secure Sockets Layer (SSL) and AES-256 bit encryption, to ensure your files are always protected. Learn more
Stop messing with printers and scanners every time you need to fill out a PDF form. You've got better things to do!
Save some dough
Edit up to 3 PDFs for free each month, or try our premium options for unlimited use. It's a much cheaper alternative to Adobe Acrobat.
Save a tree
If you're still printing out your PDF files, you should be ashamed of yourself. It's time to go green with PDF Buddy!

Thousands of people have discovered a better way to edit PDF files...
Using @pdfbuddy to edit my PDF files online! - No more printing and scanning! Just Brilliant! — Fred Bloggs (@poopoopixie) June 17, 2015
Way better than Acrobat without the headaches! Using @pdfbuddy to edit my PDF files online! — Randy Davis (@TheRandyD) January 13, 2015
Special shoutout to @pdfbuddy for making editing this PDF proposal a lot easier! *fistbump* — Peter Cung (@pvcung) April 9, 2014

Convert from PDF
Convert to PDF
Scheduled maintenance 28.02.2024
On Wednesday, February 28, we will perform scheduled maintenance from 7:30 pm PST until 10:30 pm PST. Account-related operations might be temporarily unavailable.
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Easily edit pdf text online.
Or drop a PDF file here
Private Processing
All processing is done on your device. No files are uploaded to the server.
Get Job Done Fast
Process your files in seconds – save time for more important tasks.
Work on Any Platform
Use Xodo tools on every device. Windows, Mac, Linux, Android, iOS.
How to edit text in PDF files:
Open your PDF in our online PDF Text Editor.
Use the available tools to edit and update your PDF text.
Download the edited PDF file to your device.
Edit PDF Text FAQ
Essential tools for your workflow.
PDF to PDF/A
PDF to Word
PDF to PowerPoint
PDF to Excel
PDF to HTML
PDF to Text
HEIC to JPG
HEIC to PNG
Word to PDF
Excel to PDF
PowerPoint to PDF
DICOM to PDF
HEIC to PDF
PDF Converter
OCR Converter
Delete Pages
Annotate PDF
DOCX Editor
Compress PDF
Fill in PDF Forms
Edit PDF Text
Flatten PDF
Document Reader
Validate PDF/A
Text Compare
PDF Compare
How to write on a PDF document using 3 simple steps.

See how easy it is to add text, comments, and freehand drawings to your PDFs, plus learn about more tools for editing existing text.
The PDF is one of the most widely shared file types today, with documents floating virtually between individuals, students, business partners, and more. Sometimes you need a way to add text to a PDF you receive — whether that entails filling out a form or making notes for a student or colleague — so you can keep those workflows moving along. Let’s dive into the easiest method for writing in your PDF.
3 Simple steps for adding text to a PDF.
While a PDF may not initially be the easiest file type to edit, online tools help make your document adjustable again and add the content you need. It’s easy to write in a PDF document when you use an online editor. With just a few clicks, you can add comments, text, and even freehand drawings or diagrams to further illustrate your notes. Here’s how:
	Upload your file to the PDF editor.
	Use the toolbar to add your text, comments, sticky notes, and drawings . You can also highlight , strike through , or underline existing text.
	When finished, download your file or get a link to share.

If you’re on the go, you can also use a mobile app like Adobe Acrobat Reader to write on PDFs, then share them seamlessly with colleagues or classmates right from the palm of your hand.
How to convert a PDF so you can write on it.
Need to add text to your PDF? Not a problem. Add the content you need with these simple steps:
	Open your PDF in Acrobat Pro.
	Select the Edit PDF tool in the right-hand panel. There will then be a bounding box around the editable items in your file.
	Use the editing tools to add text, edit text, or update fonts by using the selections from the Format dropdown list.
	From there, you can add, replace, move, or resize images using the tools under the Objects list.
	You can add a watermark and use the Comment tools.
	Name the file and save it as a PDF.

How to write on a PDF with a stylus.
Maybe you need to add your signature to a PDF and prefer to use a stylus for signing or creating other markups. Here’s how to write on a PDF with a stylus:
	Go to Acrobat online .
	Select a PDF to edit by clicking the “Select a file” button above, or by dragging and dropping a file into the drop zone.
	Once the file has uploaded, sign in to upload comments.
	From there you can draw, add text, and make other edits to your PDF.
	Download your file or get a link to share it with others.

How to edit text in a PDF.
It’s important to note that with most online editors, you can only add text. You cannot edit or modify the original text in the PDF. Advanced editing tools like those found in Adobe Acrobat are needed to edit text — such as fixing a typo, formatting text, or revising a section.
In addition to offering all the tools you need to make your PDF and other documents picture perfect, Acrobat makes sharing and collaborating on documents as easy as possible. Your document needs are always changing, and Adobe Acrobat was built to create ease and efficiency whenever and wherever you are working.
Explore everything you can do with Acrobat to keep edits easy and workflow moving.

Create PDF files quickly and easily with PDF24
Information, how to create pdfs.
Select the appropriate tool with which you want to create PDF files. Then follow the instructions of the tool you have chosen.
Different possibilities
With PDF24 you can create PDF files in different ways. Select and use the tool you want and create a PDF with it.
Easy to use
PDF24 makes it as easy and fast as possible to create PDF files. You don't have to install or adjust anything, you can start creating PDF files immediately.
Supports your system
There are no special requirements for your system to create PDFs. The online tools of PDF24 work under all common operating systems and browsers.
No installation necessary
You do not need to install any software. The creation of the PDF is done on our servers. Your computer, tablet or smartphone is not burdened and does not need any special requirements.
Security is important to us
The transmission of your files is protected by SSL. Your files will not be stored on our server longer than necessary, but will be completely removed from our system after a short time.
How to Edit a PDF on Windows
Need to edit a PDF on Windows? These easy-to-use tools should help you get the job done.
Quick Links
	Edit PDFs With Microsoft Word
	Edit PDFs With Microsoft Edge
	Edit PDFs With PDFgear

Key Takeaways
	To edit a PDF in Microsoft Word, convert the PDF to a Word document to freely edit it, then save it as a PDF again.
	To edit PDFs in Microsoft Edge, import the PDF and use the tools to add text, highlight, comment, and annotate, then save the edited PDF.
	You can use a dedicated PDF editor like PDFgear to edit text, change font, add annotations, watermarks, images, and passwords.

Knowing how to edit a PDF on Windows is easy when you know which apps to use. Whether you want to change the text or add annotations and comments, we're going to show you several ways to do it.
1. Edit PDFs With Microsoft Word
One of the easiest ways to edit a PDF is to use Microsoft Word. This will convert the PDF into a Word document, allowing you to freely edit it. However, you can't edit PDFs if you don't have a Microsoft 365 subscription or haven't purchased a product key.
Some PDFs don't have editable text—for example, those converted from images. If the PDF's text is not clickable, you can't edit it.
To edit a PDF in Word, open the app, click Open in the left-side menu, and find the PDF you want to edit.

You will then see a prompt telling you that Word wants to convert the PDF into an editable document. Click OK to start editing the PDF.

After you're done, click File > Save or press Ctrl + S to save the PDF. Remember, it was converted to a Word document, meaning Word will attempt to save it as that. So, in the Save As window, click the Save As Type dropdown, and select PDF .

Now you can click Save to save the edited document as a PDF again.
2. Edit PDFs With Microsoft Edge
You can also edit the PDF in Microsoft Edge . However, unlike Word, where you can edit almost every aspect, you're limited to things like adding text, highlighting text, commenting, and annotating the PDF file .
To start, import the PDF in Edge by launching the browser, and then dragging and dropping the PDF into it. Once imported, you can use the tools on the left side of the top menu to draw or add text.

You can also select text and choose to add a comment to it or highlight it with a color.

After you're done, press Ctrl + S or click Save (the floppy disk icon) on the left side of the top menu to save the edited PDF.
You can also edit a PDF in Firefox by dragging and dropping it in the browser, doing your edits, and saving the edited version. If you're using Chrome, you'll need to use the Adobe Acrobat browser extension . However, Edge is the easiest to get started with since it comes preinstalled with Windows.
3. Edit PDFs With PDFgear
Windows has free and dedicated PDF editing tools. These will allow you to edit almost every part of the PDF without needing to convert it to text. One of the easiest to use is called PDFgear.
You'll need a dedicated PDF editor if you want to use rare fonts or remove passwords from PDFs.
To start, download and install PDFgear on your computer. Afterward, open PDFgear, click Open File in the left-side menu and select the PDF file you want to edit.

Click Edit in the top menu and select Edit Text in the menu below. This will make the text in the PDF editable objects.

You can, for instance, add and delete text or change the font color and size. When you're done editing, click Exit Editing at the top. In the popup asking you to save the changes, click Yes .

Then, press Ctrl + S to save the PDF or click the save icon in the top-left corner.
You can do more than just edit text with PDFgear. You can also add annotations, watermarks, images, and signatures. You can even make the PDF secure by adding a password to it.
Now that you know how to edit PDF file on Windows, you should be able to fix or add anything to it. You can, for example, fix a mistake on an invoice, add comments to a business proposal, or annotate steps and processes. But keep in mind that the methods we've covered are only a few of the many ways to edit a PDF .
Every tool you need to work with PDFs in one place
Every tool you need to use pdfs, at your fingertips. all are 100% free and easy to use merge, split, compress, convert, rotate, unlock and watermark pdfs with just a few clicks..
Combine PDFs in the order you want with the easiest PDF merger available.
Separate one page or a whole set for easy conversion into independent PDF files.
Compress PDF
Reduce file size while optimizing for maximal PDF quality.
PDF to Word
Easily convert your PDF files into easy to edit DOC and DOCX documents. The converted WORD document is almost 100% accurate.
PDF to PowerPoint
Turn your PDF files into easy to edit PPT and PPTX slideshows.
PDF to Excel
Pull data straight from PDFs into Excel spreadsheets in a few short seconds.
Word to PDF
Make DOC and DOCX files easy to read by converting them to PDF.
PowerPoint to PDF
Make PPT and PPTX slideshows easy to view by converting them to PDF.
Excel to PDF
Make EXCEL spreadsheets easy to read by converting them to PDF.
Add text, images, shapes or freehand annotations to a PDF document. Edit the size, font, and color of the added content.
Convert each PDF page into a JPG or extract all images contained in a PDF.
Convert JPG images to PDF in seconds. Easily adjust orientation and margins.
Sign yourself or request electronic signatures from others.
Stamp an image or text over your PDF in seconds. Choose the typography, transparency and position.
Rotate your PDFs the way you need them. You can even rotate multiple PDFs at once!
HTML to PDF
Convert webpages in HTML to PDF. Copy and paste the URL of the page you want and convert it to PDF with a click.
Remove PDF password security, giving you the freedom to use your PDFs as you want.
Protect PDF
Protect PDF files with a password. Encrypt PDF documents to prevent unauthorized access.
Organize PDF
Sort pages of your PDF file however you like. Delete PDF pages or add PDF pages to your document at your convenience.
PDF to PDF/A
Transform your PDF to PDF/A, the ISO-standardized version of PDF for long-term archiving. Your PDF will preserve formatting when accessed in the future.
Repair a damaged PDF and recover data from corrupt PDF. Fix PDF files with our Repair tool.
Page numbers
Add page numbers into PDFs with ease. Choose your positions, dimensions, typography.
Scan to PDF
Capture document scans from your mobile device and send them instantly to your browser.
Easily convert scanned PDF into searchable and selectable documents.
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PDF Reader Online
Add PDF , image , Word , Excel , and PowerPoint files
Supported formats:
	Works on any device—without installation
	Free & simple tool for reading in comfort
	Start reading now—no registration needed

How To Use the Online PDF Reader:
	Drag & drop your PDF into the toolbox above.
	Wait for our software to render the document.
	Analyze, edit, share, or print the file how you like.
	Click “Download File” if you've made any changes.

PDF Reader Blog Articles

This new AI Assistant from Adobe lets you chat with your PDFs at no additional cost

Whether it's a contract you have to sign, a receipt you're viewing, or a report you're about to read, most electronic documents you interact with every day are in PDF format . To optimize how you engage with your PDFs, Adobe is introducing a new AI Assistant. 
On Tuesday, Adobe unveiled its new AI Assistant beta in Acrobat  and Reader, an AI -powered conversational engine that can answer any user question about a document, and generate summaries, and more. 
Also: I tested Meta's Code Lama with 3 AI coding challenges that ChatGPT aced - and it wasn't good
Getting started is easy. All Acrobat and Reader users will have to do is open the applications, where they will find the AI Assistant in beta, which they can then use for a range of tasks, including providing answers to recommended or user-generated questions through a chatbot. 
In addition to asking questions about the content of the document, users can also ask the AI Assistant to generate text based on the content. For example, they can ask for an email that summarizes the findings of the document. Users can then copy and paste the summary elsewhere via a "copy" button. 
The answers provided by the engine include intelligent citations, such as the pages in the document that the responses came from. Once you click on the citation, you will not only be taken to the page but also be shown a highlight of the answers on the page. 
Also:  Tech giants promise to combat fraudulent AI content in mega elections year
In addition, the AI Assistant can provide generative summaries that give users a short overview of the content, regardless of content length, giving them a good idea of the content they're about to look at before they even get started. 
"Generative AI offers the promise of more intelligent document experiences to transform information overload into actionable knowledge and professional-looking content," said Abhigyan Modi, Adobe SVP of Document Cloud. 
As users will be importing documents that are likely to include confidential information, Adobe has addressed privacy concerns. The company assures customers that data security protocols govern the new AI Assistant feature. No customer document content is stored or used to further train the technology. 
Also:  Want to work in AI? How to pivot your career in 5 steps
AI Assistant in Acrobat is available in beta at no additional cost for Acrobat Standard and Pro Individual and Teams subscription plans on desktop, according to the release. AI Assistant in Reader will be rolled out to desktop customers in English in the next few weeks, also at no additional cost, which is particularly noteworthy since Reader is a free application. 
Once, Ai Assistant leaves beta, Reader and Acrobat customers will have the opportunity to access the entire range of AI Assistant capabilities through a new add-on subscription plan. 
It is worth noting that PDF chatbots, such as ChatPDF , are already on the market. I regularly use ChatPDF as part of my generative AI arsenal  because it is great at digesting content from large documents. 
Also:  The best AI chatbots: ChatGPT and alternatives
Adobe's PDF chatbot has the potential to be even more helpful because it natively integrates its conversational engine into Reader and Acrobat, which are the standard PDF viewing platforms. Stay tuned for our hands-on review, where we'll share our first impressions of this new tool.
Artificial Intelligence

I've tried Vision Pro and other top XR headsets and here's the one most people should buy

The best AI image generators to try right now
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CBSE Class 10 English Practice Paper 2024 with Solutions: Best for Last Minute Revision
Cbse class 10 english practice paper 2024: check the cbse class 10 english practice paper with solutions to prepare for the upcoming board exam. this practice paper is as per the latest exam pattern and based on the full syllabus. download the practice paper and solutions in pdf..

CBSE Class 10 English Practice Paper PDF:  Practice paper for CBSE Class 10 English (Language and Literature) is provided here to help students practise important questions and assess their preparedness for the upcoming CBSE Class 10 English Exam which is scheduled for February 26, 2024 (Monday). The practice paper is based on the latest exam pattern, making it an essential resource for students to familiarise themselves with the questions’ format and marking scheme. Additionally, the questions included in the practice paper have been curated by experienced subject teachers based on the key topics and previous years’ trends. Download the practice paper along with solutions to prepare for your CBSE 10th English board exam.
CBSE Class 10 English: Top Tips to write perfect answers in the exam tomorrow
CBSE Class 10 English (Language & Literature) Practice Paper 2024
Section A: Reading Skills  (20 Marks)
1.Read the given text:   10   M arks
(1) Starting Monday, the country's low-cost Mars mission with the red planet for an extended period will enter the blackout phase snapping communication with the satellite. From June 8 to 22 the Sun will block Mars from the Earth snapping communication with the satellite.
(2)A senior Indian Space Research Organization official said. "That will be for the first time that there will be communication break for such a long period of about 15 days. During this period there will be no communication with the satellite, he added.
(3)Expressing confidence about regaining control over the satellite once the blackout phase is over, he said, "the scenario had been tested and the line of communication will be established" The spacecraft's life has been extended for another six months in March due to surplus fuel.
(4)Stating that the spacecraft has been "configured for the blackout, the ISRO official said, "we are not sending any commands to the spacecraft now; till 8 June few hours of signals will be sent by the spacecraft that will be for about two to three hours per day" In May next year, the mission will have to go through a similar phase once there is another extension of mission life when the Earth will come between the Sun and Mars.
(5)Scripting  space history, India on September 24 last successfully placed its low-cost Mars spacecraft in orbit around the red planet in its very first attempt, breaking into an elite club of three countries.
Based on your understanding of the extract, answer the questions below:
(i) Infer one reason for the following based on information in paragraph 1:
The blackout phase is significant---------------------
(ii) Choose the appropriate option to fill in the blank.
From paragraph 1&2, we can infer that there will be………………….
1.no communication with the people.
2. blackout phase
3. satellite will get no communication
4. moon will block the earth
5. the communication break will be for 15 days
(A) 1.2&3
(B) 1,3&4
(C) 2,3&5
(D) 3,4&5
(iii) According to ISRO official till 8 June, when Sun will block Mars……………. Signal/signals per day will be sent to the spacecraft
(B) considerable
(C) indefinite
(D) only few
(iv) Complete the following sentence.
(iv) The ISRO officials are............. about their control over the spacecraft after the blackout phase.
(A) Doubtful
(B) Apprehensive
(C) Confident
(D) jittery
(v) The spacecraft's life was extended by six months because of
(A) extra fuel
(B) incomplete work
(C) lack of communication amongst ISRO officials
(D) technical problems in its landing
(vi) Read the following sentence:
(a) The blackout was a sudden development.
(b) Because of this, the officials are very nervous about the success of the spacecraft.
(A) Both (A) & (B) are true
(B) Both (A) & (B) are false.
(C) (A) is true and (B) is false.
(D) (A) is false and (B) is true.
(vii) Find the word  in the 1st para which means the same as ‘a sudden break’…………..
(viii) Throw light on India's script in space history in about 40 words.
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